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Introduction

This document will guide you through the installation and configuration process for the
FreeFlow Output Manager and FreeFlow Accounting Module.

Before you use this guide

This guide is intended for users of workstations using one of the following web browsers:

e Internet Explorer 8.x or 10.x
e Firefox 3.0, 3.5., 3.6.

Note

FreeFlow Output Manager requires Internet Explorer 8.x and 10.x to be set to run in
Compatibility Mode for the application to function properly.

You should be familiar with using a web browser.

About this guide

Before you perform any procedures in this guide, become familiar with its contents and
conventions.

Conventions

This guide includes the following conventions:

e Angle brackets: Variable information that is displayed on your window or that can be
entered as part of a command line is enclosed within angle brackets. Examples include
“Unable to copy <filename>;” “set -p <printer>.”

e Square brackets: Square brackets are used for the following:
— Names of menu options that you select; for example, Printer Default
— Names of buttons that you select; for example, OK and Cancel

— Names of text boxes, list boxes, and fields; for example, “the From text box,” the
Directories list box,” “The Color Source field”

e Bold: Boldface type is used for the following:
— Directory paths; for example, “Browse to the Win_nt40/Xeroxdrv directory.”

— Text that you enter; for example, “Enter purple or XDS.”

Installation and Configuration Guide
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Introduction FreeFlow Output Manager

— Calling attention to text that is particularly important; for example, “Select [Stop] on
the user interface window. Do not press the red stop button on the controller.”

— Introductory words or phrases that begin items in a list; for example, [Hold job]: The
document is held at the printer... or [Cancel job]: The document is not printed...

e Notes: Notes are hints that help you perform a task or understand the text. Notes are
presented in separate paragraphs. Example:

Note
You cannot submit a job unless the printer is connected to your workstation.

Related documentation

For further information about your specific Xerox printer and print service or controller, refer to
the documentation that was delivered with your system.

Customer Support

For customers in the United States:

e To place a customer service call, dial 1-800-821-2797 for assistance.

For customers in Canada:

e To place a customer service call, dial 1-800-939-3769 for assistance.

For other locations, call your local customer support center for assistance.
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Installation and
configuration for
Windows

This chapter contains the information that you need to install the FreeFlow Output Manager
and FreeFlow Accounting Module applications.

Workstation requirements

Your workstation must meet the following hardware and software requirements to run the
software:

Minimum Hardware requirements

e Processor: Dual Processor Intel® Xeon 2.8 GHz equivalent or better
e RAM:4.0GB
e Hard Disk Space: 250 GB plus any additional expected spool space

Note

Additional spool space may be required depending upon the type and size of jobs
submitted to the platform.

e Ethernet Capability: 10/100/1000 Mb/sec

Minimum Software requirements

To use the software, your PC workstation must be running one of the following operating
systems:

e Windows Server 2003 with SP2 or Windows Server 2003 R2 with SP2
e Windows Server 2008 with SP2

e  Windows Server 2008 R2 (run under 32 bit compatibility)

e Windows Server 2012 Standard
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One of the following Internet browsers is also required:

e Internet Explorer 8.x or 10.x
e Mozilla Firefox 3.0, 3.5, or 3.6

Note

FreeFlow Output Manager requires Internet Explorer 8.x and 10.x to be set to run in
Compatibility Mode for the application to function properly.

Installing FreeFlow Output Manager and
FreeFlow Accounting Module

This section details the installation instructions for the FreeFlow Output Manager and FreeFlow
Accounting Module software.

Installation Prerequisites

The following services must be disabled before you install the software:
e  TCP/IP Print Server -- known as Print Services for UNIX

e Internet Information Services

Disable the Indexing Service: following service under Control Panel > Administrative Tools >
Services

e Server 2003: Open the Control Panel. Select, Administrative Tools > Services. Disable
the Indexing Service

e Server 2008: Open the Control Panel. Select, Administrative Tools > Services. Disable
the Windows Search service.

e Server 2012: Open the Start Menu. Type Server Manager, and press Enter. Select
[Tools, Computer Managent] Select [Services and Applications, Services] Disable the
Windows Search service, if listed.

Disable Hyper-threading in the PC BIOS (if option exists)

The following must be installed before you install the software:
e Microsoft .NET Framework 3.5 Service Pack 1

Installing the software

In order to install the software, you must be logged in as a user with Windows Administrator
rights.
Note

FreeFlow Output Manager provides an embedded JMF Service. Do not install the
standalone FreeFlow JMF Service.

Note

The fullinstaller includes SP 10. It is not necessary to install the SP 10 patch after installing
the full version.
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To install the software:

1.

10.

11.

12.

Insert the FreeFlow Output Manager CD into the PC. The disk will autorun.

Note

If the installation does not start automatically, navigate to the CD/DVD drive, and double
click on the installation program.

At the splash screen, select the appropriate language from the pull-down menu and click
OK.

At the Xerox FreeFlow Output Manager Introduction screen, click Next.

At the Software License Agreement screen, select the I accept... option to accept the End
User License Agreement terms. Click Next.

At the Choose Install Set screen select the installation type, then select Install. Options
include:

—  Typical: installs the full set of applications including Output Manager, Accounting
Module and the Printer Registration application.
— Minimal: installs only the Output Manager and Printer Registration applications.

—  Custom: allows you to select the applications to be installed. Enable the check mark
next to the applications that you want to install.

At the Choose Install Folder screen, accept the default installation folder or select another
installation location. Click [Next] to proceed with the installation or [Cancel] to abort the
installation.

Note

It is possible that for a reinstall or upgrade this screen may not appear.

Note

If your PC has multiple partitions, install FreeFlow Output Manager in the partition that has
the most available free disk space.

At the Choose Shortcut Folder screen, make a selection for where you want to create the
product icons. Click Next.
Note

If you want to create the product icons on all desktops, mark the checkbox for Create Icons
for All Users.

Enter the serial number that is provided with the CD.

Note
It is possible that for a reinstall or upgrade this screen may not appear.

At the pre-installation summary screen, click Install. The installation of FreeFlow Output
Manager begins.

At the Install Software License screen, the license name and directory location is noted. For
information on installing the license file see Licensing FreeFlow Output Manager on page 4.
Click Next.

Note

It is possible that for a reinstall or upgrade this screen may not appear.

After the installation is complete, ensure that the Yes, restart my system radio button is
selected.

Click Done. The system reboots.
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Licensing FreeFlow Output Manager

The software is protected through the use of a license manager. A permanent license must be
acquired at the time of installation. All systems running the software require a valid license file
for operation.

For customers in the United States, Canada, and Europe, the license file is acquired via the
Xerox Software Activation Portal. Using the supplied activation key, go to the following website
to obtain the license file: https://www.xeroxlicensing.xerox.com/activation.

For other countries, please contact your local support representative for assistance in obtaining
a license file.

You need to be prepared to provide your FreeFlow Output Manager serial number and MAC
address when acquiring the license. A license file will be issued that will enable the FreeFlow
Output Manager applications. A backup copy of this license file should be stored to an achieve
location (backup disk, DVD/CD-ROM, USB storage device, etc.).

Determining your system’s MAC address

To determine your system’s MAC address:
1. Open the Command Prompt:

a. For Windows Server 2003 or 2008: From the Start Menu, select Start: Programs:
Accessories: Command Prompt.

b. For Windows Server2012: Open the Start Menu, type Command Prompt, and press
Enter.

At the command prompt, enter ipconfig /all.

The MAC Address is known as the Physical Address value, and will be displayed on screen in
the format xx-xx-xx-xx-xx-xx. Write this information down and have it ready when you
access the Xerox Software Activation Portal web site.

Installing the license file

To install the license file:

1. Locate the license file you obtained from Xerox.
Copy the file to a location on the PC.

Rename the file to xrx_ffom.lic.

Select the file and select Edit:Copy.

e wNnN

Browse to the following location: <directory where the software was installed>\license, and
paste the file in that folder.

If asked whether you want to overwrite the existing file, select Yes.
Reboot the system.
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Configuring Users and Group
Authorizations

The installer will create the user groups necessary to use the system. The system administrator
must add users to those groups to enable user and administrator access to the software; the
groups allow access to all or a limited set of administration commands.

Note

If you wish to create new users to administer the software, follow the steps described in
“Setting Up FreeFlow Output Manager Users” and then proceed to “Setting Up FreeFlow
Output Manager Authorization Groups.”

The groups are named:

e Xerox FreeFlow Output Manager Administrators
e Xerox FreeFlow Output Manager Operator1s

e Xerox FreeFlow Output Manager Operator2s

e Xerox FreeFlow Output Manager Operator3s

e Xerox FreeFlow Common Printer Administrators

The FreeFlow Accounting Module group is named:

e Xerox FreeFlow Accounting Module Administrators

If the system will be setup to enable custom views using the Custom View Groups, you will need
to create those groups and add users to them. see the section Setting up Custom View Groups
on page 8.

Setting up FreeFlow Output Manager Users

To set up users to perform administrative tasks on FreeFlow Output Manager, perform the
following steps:
Note

You can use the existing Windows administrator account on the system, or create an
administrator account specifically for Output Manager.

1. Perform one of the following:

— For Windows Server 2003: Right-click My Computer and select Manage. In the left
pane of the Computer Management window, expand the display to reveal System
Tools: Local Users and Groups: Users.

— For Windows Server 2008: Right-click My Computer and select Manage. In the left
pane of the Server Manager window, expand the display to reveal Configuration:
Local Users and Groups: Users.

— For Windows Server 2012: Open the Start Menu. Type Server Manager and press
Enter. Select [Tools, Computer Management]. In the left pane of the Computer
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Management window, expand the display to reveal System Tools: Local Users and
Groups: Users.

Right-click Users and select New User.

In the supplied text field, enter a user name.

In the supplied text field, enter the full user name.

If desired, enter a description of the user.

Type a password, then retype it.

Select the desired password options by clearing or marking the supplied check boxes.

©® NO B WwWN

Select Create. The user will appear in the right pane of the Computer Management
window.

9. Repeat steps 4-9 to create additional users.
10. Select Close when you are finished adding users.

Setting up FreeFlow Output Manager Authorization Groups

1. Perform one of the following:

— For Windows Server 2003: Right-click My Computer and select Manage. In the left
pane of the Computer Management window, expand the display to reveal System
Tools: Local Users and Groups: Groups.

— For Windows Server 2008: Right-click My Computer and select Manage. In the left
pane of the Server Manager window, expand the display to reveal Configuration:
Local Users and Groups: Groups.

— For Windows Server 2012: Open the Start Menu. Type Server Manager and press
Enter. Select [Tools, Computer Management]. In the left pane of the Computer
Management window, expand the display to reveal System Tools: Local Users and
Groups: Groups.

Select the Xerox FreeFlow Output Manager Administrators.

Select Add to add members to the group.

In the supplied text field, enter the user name you wish to add to the group.

Select OK. The user or users will be added to the group.

Repeat steps 3-5 to add any additional users to the group.

No v s WwN

Repeat steps 3-6 to add users to the following group names:
—  Xerox FreeFlow Output Manager Operator1s

—  Xerox FreeFlow Output Manager Operator2s
—  Xerox FreeFlow Output Manager Operator3s

8. Select [Close] when you are finished adding users.

Setting up FreeFlow Common Printer Administrator Group

Users added to the Common Printer Administrator are allowed to use the Printer Administration
application to add printers to the system.

1. Perform one of the following:

— For Windows Server 2003: Right-click My Computer and select Manage. In the left
pane of the Computer Management window, expand the display to reveal System
Tools: Local Users and Groups: Groups.
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— For Windows Server 2008: Right-click My Computer and select Manage. In the left
pane of the Server Manager window, expand the display to reveal Configuration:
Local Users and Groups: Groups.

— For Windows Server 2012: Open the Start Menu. Type Server Manager and press
Enter. Select [Tools, Computer Management]. In the left pane of the Computer
Management window, expand the display to reveal System Tools: Local Users and
Groups: Groups.

Select the Xerox FreeFlow Common Printer Administrators.

Select Add to add members to the group.

In the supplied text field, enter the user name you wish to add to the group.

Select OK. The user or users will be added to the group.

Repeat steps 3-5 to add additional users.

No v WwN

Select Close when you are finished adding users.

Setting up FreeFlow Accounting Module Authorization Group

1. Perform one of the following:

— For Windows Server 2003: Right-click My Computer and select Manage. In the left
pane of the Computer Management window, expand the display to reveal System
Tools: Local Users and Groups: Groups.

— For Windows Server 2008: Right-click My Computer and select Manage. In the left
pane of the Server Manager window, expand the display to reveal Configuration:
Local Users and Groups: Groups.

— For Windows Server 2012: Open the Start Menu. Type Server Manager and press
Enter. Select [Tools, Computer Management]. In the left pane of the Computer
Management window, expand the display to reveal System Tools: Local Users and
Groups: Groups.

Select the Xerox FreeFlow Accounting Module Administrators.

Select Add to add members to the group.

In the supplied text field, enter the user name you wish to add to the group.

Select OK. The user or users will be added to the group.

Repeat steps 3-5 to add additional users.

No vy whN

Select Close when you are finished adding users.
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Setting up Custom View Groups

The Custom View Groups are used to create custom views of Output Manager. When
configured using the FreeFlow Output Manager System Configuration screen, users will only be
able to view the queues, printers, and jobs that the Custom View Groups they are assigned to
are permitted to view.

Important considerations

|

* WARNING
When configuring Output Manager, the Output Manager administrator should determine
whether to enable or disable this feature. Only a single mode is supported. Switching between
the modes will compromise the integrity of the system.

Setting up a custom view group is a 2-step process:

e Custom View Groups must be created by IT Administrator.

— The groups must be created using a “Xerox FFOM <customer designation>” syntax. For
example, a valid group could be named “Xerox FFOM Westwing Printshop.”

Note

FreeFlow Output Manager cannot recognize Custom View Groups without the “Xerox
FFOM...” prefix.

Note

If the system administrator changes the Custom View Groups group name for
whatever reason, it will be not be reflected in Output Manager. The application will
treat the altered group name as a new group. The application cannot track group
name changes and then update the queue or printer assignments.

e  Printer and Queue assignment must be performed by FreeFlow Output Manager
Administrators.

— Printers and queues can only be assigned to one group at a time. Once a printer or
queue is assigned, it becomes unavailable for new assignment.

When Custom View Groups is enabled, unauthorized guest login is not supported. Guest users
must have valid logins and must be added to the appropriate groups.

Creating Custom View Groups

1. Perform one of the following:

— For Windows Server 2003: Right-click My Computer and select Manage. In the left
pane of the Computer Management window, expand the display to reveal System
Tools: Local Users and Groups: Groups.

— For Windows Server 2008: Right-click My Computer and select Manage. In the left
pane of the Server Manager window, expand the display to reveal Configuration:
Local Users and Groups: Groups.

— For Windows Server 2012: Open the Start Menu. Type Server Manager and press
Enter. Select [Tools, Computer Management]. In the left pane of the Computer
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Management window, expand the display to reveal System Tools: Local Users and
Groups: Groups.
Right-click Groups and select New Group.

In the supplied text field, type the name using the proper Custom View Groups syntax:
“Xerox FFOM <customer designation>.”.

If desired, enter a description of the new group.

Select Add to add members to the group.

In the supplied text field, enter the user name you wish to add to the group.
Select OK. The user or users will be added to the group.

Select Create. The group will be created.

Repeat steps 2-8 to create additional Custom View Groups.

. Select Close. The necessary groups have been created and the appropriate users have been

added to them.

Proceed to the following sections, Performance Settings and Job Ordering on page 10 and
Creating a queue on page 13.

Once the necessary printer and queues have been created, use the FreeFlow Output Manager
System Configuration screen to enable the Custom View Groups feature and assign queues and
printers to the various groups. See the FreeFlow Output Manager online help for more
information on configuring this feature.
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Setting up an initial printer and queue

Before you can use FreeFlow Output Manager, you must set up printers and queues. This
section of the Installation and Configuration Guide will help you to create a simple queue and
printer.

Note

It is not within the scope of this Guide to provide detailed instructions for these activities;
rather, this Guide provides simple, general instructions. Detailed instructions for creating
specialized queues and specific printers are provided in the Online Help.

Performance Settings and Job Ordering

In order to increase job throughput, multiple submission threads can be used to send jobs to
the printers simultaneously. This setting is controlled by the MAX_THREADS property. To
change this setting:

1. Open the file OBS.properties in <OM installation directory>\config directory (by default,
C:\Program Files\Xerox\FreeFlow Output Manager\config, or for Server 2012, C:\Program
Files (x86)\Xerox\FreeFlow Output Manager\config)

2. Locate the string MAX_THREADS and replace the value on the right. By default, it is set to 5
Example: MAX_THREADS=10 (to set value to 10)

When multiple thread feature (MAX_THREAD > 1) is enabled, jobs are submitted to the printers
in the order determined by the OM queue policy but they may arrive at the printer out of order.
While this is acceptable to some customers, it is a problem for customers who require jobs to be
in order. This is especially a problem for the iGen4 220 Perfecting Press for which FFOM is the
front end controller. The iGen4 220s expect jobs to be sent to both DFE1 and DFE2 in order.

The setting that controls this behavior is JOB_ORDER which indicates whether job order is
required. By default, it is to set to ORDER. While this guarantees that jobs will arrive at the
printer in the right order, it limits the number of submission threads to each DFE queue to 1. If
job order is not important, it is advisable to set this value to UNORDER. To change this setting:

1. Open the file OBS.properties in <OM installation directory>\config\ directory (by default,
C:\Program Files\Xerox\FreeFlow Output Manager\config, or for Windows Server 2012,
C:\Program Files (x86)\Xerox\FreeFlow Output Manager\config)

2. Locate the string JOB_ORDER and replace the value on the right. There are two options:

e UNORDER: Use maximum number of threads to submit jobs. Jobs are submitted in the
order determined by the OM queue policy but due to the job size and network factors,
jobs may arrive at the printers out of order. Currently ORDER is the default job ordering
policy.

e ORDER: Ensure that jobs arrive at the DFE queue in the order determined by the OM
queue policy. If this policy is used, a single thread will be used for each DFE queue. The
maximum number of threads used is determined by the number of active DFE queues
(the target DFE queues where jobs are being printed) up to MAX_THREADS.

Important: If you change either or both options (MAX_THREADS and JOB_ORDER) above, you
must restart FFOM for the settings to take effect.

2-10 Installation and Configuration Guide



FreeFlow Output Manager Installation and configuration for Windows

Configuring Hot Folder

If a hot folder is mapped to a remote share and the connection to the remote share is lost, the
Hot Folder Service will attempt to re-establish connection at a set interval. To change this value:

1. Open the file HotfolderService.properties in <OM installation directory>\config\ directory
(by default, C:\Program Files\Xerox\FreeFlow Output Manager\config\, or for Windows
Server 2012, C:\Program Files (x86)\Xerox\FreeFlow Output Manager\config)

2. Locate the string connectionRetryFrequency and replace the value on the right. By default,
it is set to 60 seconds. Example: connectionRetryFrequency=90 (to set to 90 seconds)

3. Restart FFOM_HotFolderService from Windows Services

Creating a printer

The production printers that are used by FreeFlow Output Manager are made available through
the Printer Registration application. Printer Registration maintains a list of production printers
and their configured settings. The printer list can reside on the same computer as the Output
Manager application or the list can reside on a remote computer. When adding production
printers, use the following guidelines:

Note

For detailed information on how to use the Registered Printer List Locator or the Printer
Registration application, see the online help for those applications.

Note

When adding a printer using the Printer Registration application, the name of the Output
Manager printer cannot contain the following characters <space>,I,.,* <,>,/,\,", 2.
Note

It is best practice to keep the custom name for the printer as short as possible so as to keep
the name from wrapping in the Output Manager interface.

e Access the Registered Printer List Locator and select the [Local] or [Remote] option
depending on whether you will create the printer list locally or on a remote PC.

Note

If you select the Remote option and then attempt to access the Printer Registration
application on the local PC, you will receive an error message.

e Access the Printer Registration application by performing one of the following:

— For Windows Server 2003 or 2008: select [Start : Xerox FreeFlow Applications: Printer
Administration: Registered Printer List Locator].

— For Windows Server 2012: Open the Start Menu, type Registered Printer List Locator
and press Enter.
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If you selected the [Local] option, use the application on the same PC as Output Manager. If
you selected the [Remote] option, access the application on the PC that will be used to maintain
the printer list. To access the Printer Registration application:

1.

Perform one of the following steps:

e For Windows Server 2003 or 2008: Select [Start, Programs, Xerox FreeFlow
Software, Printer Administration, Printer Registration].

o For Windows Server 2012: Open the Start Menu, type Printer Registration and press
Enter.

On the Installed Products dialog, ensure that the Output Manager check box is selected
and click OK.

Click the Add... button to add a printer. Follow the steps in the Add Printer Wizard to add
the printer and its corresponding queues.

Note

If you are using the FreeFlow Accounting Module, you will need to enter the location of
the accounting log created on the FreeFlow Printer Server. For instructions on how to
configure the FreeFlow Printer Server, see the online help for the Accounting Module
after the installation is completed. Once the print server has been configured, re-enter
the Printer Registration application and edit the printer settings to enter the necessary
server information.

4, Continue to add printers if necessary. Once you have finished, close the Printer Registration

application.

Once you have added the necessary production printers using the Printer Registration
application, you can then add the registered printers to FreeFlow Output Manager.

Note

For detailed information on how to change the printer list in Output Manager, see the
FreeFlow Output Manager online help.

Double-click the FreeFlow Output Manager shortcut icon on the desktop to open the
application.

Logon as a user who is a member of the Xerox FreeFlow Output Manager System
Administrators group.

Click Printer Manager.

Select the Change Printer List ... button. The Add/Remove Printer list window opens. The
printers that are available for Output Manager have check boxes to the left of the printer
name or IP address.

Ensure that the check box to the left of the printer name or IP Address for those printers
you want to add is selected. Deselect the check box for any printer you do not want to add
at this time.

Select the Next button to move through the various screens. When you reach the final
screen in the process, click Done to add the printers and return to the Printer Status screen.
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Creating a queue

FreeFlow Output Manager uses a New Queue Wizard to ask a series of questions when creating
a queue. Before you create a queue, you will need to know the following:

e  What production printer or printers do you want to assign to the queue?

e  Will the queue utilize job splitting? If so, what type of job splitting method will be utilized?

Once you have determined the type of queue and the production printers you want to assign to
it, you can create the queue.
Note

For detailed information on how to create a queue in Output Manager, see the FreeFlow
Output Manager online help.

1. Double-click the FreeFlow Output Manager shortcut icon on the desktop to open the
application.

2. Logon as a user who is a member of the Xerox FreeFlow Output Manager System
Administrators group.

3. Click Queue Manager.
Click the New Queue... button.

Follow the steps in the Create Queue Wizard screen to create the new queue and assign it
the necessary production printers.

6. Click Next.
7. Select Done. The queue will be displayed in the Queue List.

Configuring access to a document
repository

Before FreeFlow Output Manager can access a document repository (for example,
Documentum, DocuShare or SharePoint), it is necessary to edit the Output Manager System
Configuration.

Perform the following:

1. Double-click the FreeFlow Output Manager shortcut icon on the desktop to open the
application.

2. Logon as a user who is a member of the Xerox FreeFlow Output Manager System
Administrators group.

3. Click the System Configuration link at the top of the right of the page.
Click the Repository Location heading to jump to that section.

Enter the Server Name or IP address of the server hosting the document repository. You can
also enter the port number for the repository server.

6. The port number should match the port for the Repository Service, not the port for
Sharepoint, Documentum, or DocuShare web service.

7. Click Apply to save the settings.
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DocuShare Support

If Output Manager is being used with DocuShare, the default .NET Framework version needs to
be set to 2.0.

1. Open the Start Menu. Type Internet Information Servcies (IIS) Manager and press Enter.
If necessary, select the local host in the left pane.

In the right pane, select [View Application Pools].

Right-click on [DefaultAppPool] and select [Set Application Pool Defaults...].

Under (General), select the .NET Framework Version drop-down, and select [v2.0].

Select [OK].
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Backing up and Restoring FreeFlow
Output Manager

After configuring printers and queues, it is a good idea to periodically backup the configuration
information in the unlikely event of a catastrophic failure of your system.

The FreeFlow Output Manager configuration settings and data that is backed up and restored
are the following:

e  Output Manager application configuration settings.

Jobs, Queues, and Printers.
e Hot Folders and Port Controller configuration settings
e Accounting Module configuration settings, reports, database, and exported data.

o If the Printer Registration and/or Standalone Repository Management System are present
on the machine, the configuration settings for those applications are backed up and
restored.

There are two means of invoking the backup and restore application:
e Using the Backup/Restore Utility Windows application.
e Using a command line to activate the backup or restore processes.

Note

The backup and restore operations will automatically shutdown and restart the Output
Manager and Accounting Module services.

Backup or Restore using the Windows application

Note

You must be logged in as the Windows Administrator to perform the backup or restore
operations.

If you are using the Windows Server 2008 application, right-click on the Start menu GUI
command and select Run as Administrator to run the program as an Administrator.
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Perform the following to backup the Output Manager system
1. Perform one of the following steps:

e For Windows Server 2003 or 2008, Select Start: Programs: Xerox FreeFlow: Output
Manager: Backup.

e For Windows Server 2012, Open the Start Menu, type Backup, select the [Backup]
application.

In the browse dialog, select a folder location to save the backup information.
Enter a file name in the text box or accept the default file name.

Note

If you specify a file name that is a duplicate of a previous backup, a dialog will display.
Select Yes to overwrite the previous backup, or No to specify an alternate filename.

Select Save. A progress bar dialog will display the status of the backup.
Select OK when the operation is complete.

Perform the following to restore the Output Manager system:
1. Perform one of the following steps:

e For Windows Server 2003 or 2008, Select Start: Programs: Xerox FreeFlow: Output
Manager: Restore.

e For Windows Server 2012, Open the Start Menu, type Restore, select the [Restore]
application.

In the browse dialog, select a folder location of the backup information.
Select the ZIP file containing the backup information you want to restore.
Select Open. A progress bar dialog will display the status of the restore operation.
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Select OK when the operation is complete.

Backup or Restore using the command line

Note

You must be logged in as the Windows Administrator to perform the backup or restore
operations.

If you are using the Windows Server 2008 or 2012, right-click on the Command Prompt
icon and select Run as Administrator to run the program as an Administrator.

Perform the following to backup the Output Manager system

1. From the /bin folder located in the Output Manager installation directory, enter the
ffom_backup command followed by a fully qualified path to the backup file to be created.

e For example: ffom_backup c:\Backup\<todays_date>

Note

If you do not specify a backup path, the ffom_backup will create a backup file in a
default location. The default location will be in the <installation directory>\backup.

Perform the following to restore the Output Manager system:

1. From the /bin folder located in the Output Manager installation directory, enter the
ffom_restore command followed by a fully qualified path to the backup file to be restored.

e For example: ffom_restore c:\Backup\<todays_date.zip>
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U

ninstalling FreeFlow Output Manager

If you wish to uninstall the software, perform the following steps:

1.
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2-16

Perform one of the following steps:
— For Windows 2003: Select [Start: Settings: Control Panel]. Select [Add or Remove
Programs].

— For Windows 2008: Select [Start: Settings: Control Panel]. Select [Programs and
Features].

— For Windows 2012: Open the Start Menu, type Control Panel, and press Enter. Select
[Programs, Programs and Features].

From the list, select Xerox FreeFlow Authorization Service.

Select Change/Remove.

From the list, select FreeFlow Output Manager <version number>.

Select Change/Remove.

At the Uninstall FreeFlow Output Manager window, select Uninstall. The process will run.

Note

If you also want to remove the Printer Registration utility, select FreeFlow Printer
Registration <version number>. At the Uninstall FreeFlow Printer Registration window
select Uninstall. The process will run.

Make note of the items that could not be removed. You may wish to remove them
manually.

Select Done.
Close the Add/Remove Programs window.

. If desired, manually remove the files that were not automatically removed by the

uninstaller.

. Restart your PC to complete the uninstall.
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Upgrading the FreeFlow Output
Manager 8.0 software to version 9.0

This procedure is used to upgrade FreeFlow Output Manager version 8.0 software to version 9.0.
The procedure requires that the system configuration be saved, the version of Output Manager
be uninstalled, and the latest version of Output Manger be installed and configured.

Note

Uninstalling the software will not delete FreeFlow Output Manager setup items, such as
created queues, printers, jobs, scripts, users and groups, nor configuration and licensing
information. To completely remove these items, delete the directory where the software
was installed. Example: C:\Program Files\Xerox\FreeFlow Output Manager.

If you have a version of Output Manager earlier than version 8, upgrade using the “Upgrading
FreeFlow Output Manager” procedure found in the 8.0 version of your FreeFlow Output
Manager Install and Configuration Guide (p/n 701P49182). Once you have confirmed that you
have a working version 8 of Output Manager, follow this procedure to upgrade to version 9.

A new license file will be required to run the software after the upgrade.

1. Stop all queues from accepting any more jobs. Stop all Hot Folders and Port Controller
sources.

Output all jobs to the appropriate printers.
Delete or purge all non-required jobs.
Hold all remaining jobs.
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Backup the necessary folders using the procedure “Backing Up and Restoring FreeFlow
Output Manager”of the 8.0 version of your FreeFlow Output Manager Install and
Configuration Guide (p/n 701P49182).

6. Uninstall FreeFlow Output Manager per the procedure Uninstalling FreeFlow Output
Manager on page 16.

7. Install FreeFlow Output Manager per the procedure Installing FreeFlow Output Manager
and FreeFlow Accounting Module on page 2. Perform all sub-procedures.
Note

Ensure that you preform all install prerequisites before you install the new version of Output
manager. In particular, ensure that Microsoft .NET Framework 3.5 SP1 is installed.

8. Install a new license file. See Licensing FreeFlow Output Manager on page 4 for more
information.

9. Start the FreeFlow Output Manager application and verify all user and printer settings are
present.

10. Installations that use the Accounting Module must be restored from backup after
upgrading to Output Manager 9.0.
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Migrating FreeFlow Output Manager 9.0
to a different system.

This procedure describes how to migrate FreeFlow Output Manager version 9.0 to a different
system. The system you are migrating to could have the same operating system version or
another supported version.

1. Stop all queues from accepting any more jobs. Stop all Hot Folders and Port Controller
sources.

Output all jobs to the appropriate printers.
Delete or purge all non-required jobs.
Hold all remaining jobs.
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Backup the necessary folders using either the FreeFlow Output Manager backup utility or
the Command Line executable. See Backing up and Restoring FreeFlow Output Manager on
page 14 for more information.

6. Uninstall FreeFlow Output Manager from the old system per the procedure Uninstalling
FreeFlow Output Manager on page 16.

7. Install FreeFlow Output Manager on the new system per the procedure Installing FreeFlow
Output Manager and FreeFlow Accounting Module on page 2. Ensure that the install
directory is the same as the install directory using on the older system.

Note

Ensure that you preform all install prerequisites before you install the new version of Output
manager. In particular, ensure that Microsoft .NET Framework 3.5 SP1 is installed.

8. Perform all sub-procedures.

9. Acquire and install a new license file on the new system. Please contact your local support
representative for assistance in obtaining this license file. See Licensing FreeFlow Output
Manager on page 4 for more information on providing your FreeFlow Output Manager
serial number and MAC address. The local support representative is the one that will
request this new license file as you "move” the FreeFlow Output Manager from your
previously licensed system to the new system.

10. Restore the information backed up in step 5 using the Windows application or Command
Line executable. See Backing up and Restoring FreeFlow Output Manager on page 14 for
more information.

11. Start the FreeFlow Output Manager application and verify all user and printer settings are
present.
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Migrating FreeFlow Output Manager 9.0
on the same system after installing a
newer Operating System

This procedure describes how to migrate FreeFlow Output Manager version 9.0 on the same
system after the operating system version has been changed.

1. Stop all queues from accepting any more jobs. Stop all Hot Folders and Port Controller
sources.

Output all jobs to the appropriate printers.
Delete or purge all non-required jobs.
Hold all remaining jobs.
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Backup the necessary folders using either the Windows Backup application or the
Command Line executable. See Backing up and Restoring FreeFlow Output Manager on
page 14 for more information.

6. Store the backup data and a copy of your license file in a safe location. This is especially
necessary if the hard disk for the system will be reformatted.

7. Uninstall FreeFlow Output Manager per the procedure Uninstalling FreeFlow Output
Manager on page 16.
Note

If you will reformatting the hard drive before the installation of Windows Server 2008, you
can skip step 7.

8. Install the new version of Windows Server operating system.

9. Install FreeFlow Output Manager per the procedure Installing FreeFlow Output Manager
and FreeFlow Accounting Module on page 2. Ensure that the install directory is the same as
the install directory using on the older operating system.

Note

Ensure that you perform all install prerequisites before you install the new version of Output
manager. In particular, ensure that Microsoft .NET Framework 3.5 SP1 is installed.

10. Perform all sub-procedures.

11. Restore the information backed up in step 5 using the Windows application or Command
Line executable. See Backing up and Restoring FreeFlow Output Manager on page 14 for
more information.

12. Start the FreeFlow Output Manager application and verify all user and printer settings are
present.
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FreeFlow Output
Manager web
interface software

This chapter contains procedures for administering FreeFlow Output Manager using the
FreeFlow Output Manager web interface.

Although FreeFlow Output Manager applications are installed on a single host, the primary
Graphical User Interface (GUI) is accessed through a web browser, and can therefore be run on
any connected host.

With FreeFlow Output Manager you use a browser to access menus and tabs that enable you to
select a document file, set up a job ticket, and submit your print job to the printer.

Internet Explorer 10

Internet Explorer 10must be set to run in Compatibility Mode in order for Output Manager to
function properly when using that browser version.

Configuring Internet Explorer 10

Open the Internet Explorer application.
If necessary, navigate to the Output Manager login page.
Press Alt, and select [Tools, Compatibility View Settings].

The Output Manager web site address should be highlighted in the Add this website text
box. Select Add.

Select Close.

)

Perform steps 1-5 again, but for step two navigate to the Accounting Module login page.
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Firefox browsers

Before the Firefox browsers can be used, the security settings must be configured to connect to
FreeFlow Output Manager.

Configuring the Firefox browser

The SSL settings for the Firefox browser require only SSL3 to be enabled. SSL2 is to be disabled.
Perform the following to configure these settings:

1. Open the Firefox browser application.
2. Inthe navigation bar type about:config
3. Inthe filter text box type 128
4. In the results below locate the string:

—  security.ssl3.dhe_rsa_aes_128_sha

5. Double-click on that link (this will turn the value to false)

You can now log in to the FreeFlow Output Manager server using this browser.

Accessing the FreeFlow Output Manager
and Accounting Module web interface
software

To log into the application and to ensure system security, Administrators and Operators must
have a registered user account with an assigned user name and password.

Note

Use the Windows operating system to create and manage user accounts.

To access the FreeFlow Output Manager or the FreeFlow Accounting Module:

1. If there is an icon on your desktop, double-click the icon. If not, select [Start: Program Files:
Xerox FreeFlow Output Manager: <application name>. The login page displays.
Note

You can access FreeFlow Output Manager from within the browser by entering the URI:
http://localhost:8080/WebClient/Controller or http://<IP address of the FreeFlow
Output Manager server>:8080/WebClient/Controller.

Note

You can access FreeFlow Accounting Module from within the browser by entering the URI:
http://<ipaddress or hostname of Accounting Module server>:9090/WebClient/
Login.do.
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2. Login to the application:
a. Inthe User Name text box, enter your user name.
b. Inthe Password text box, enter the password.
¢. Inthe Domain text box, enter the computer name.
d. Select Log In.

Note

If you are logging in using a Firefox browser, a certificate acceptance screen will
appear. Select the [Accept this certificate permanently] to avoid seeing this screen
each time you log in.

Note
Enable the allow pop-ups option when accessing application remotely using a browser.

Accessing the Port Controller and Hot
Folders

The Port Controller and Hot Folders can be accessed by selecting Start: Programs: Xerox
FreeFlow: Output Manager: Port Controller or Start: Programs: Xerox FreeFlow: Output
Manager:Hot Folders, or, if they do not appear, perform the following procedure:

1. Open My Computer.

2. Browse to the location in which the software is installed. For most installations, this will be
C:\Program Files\Xerox\FreeFlow Output Manager.
Note
For installations on Windows 2008 R2 or Windows Server 2012, the directory will be

C:\Program Files (x86)\Xerox\FreeFlow Output Manager.
3. Double-click the bin folder. This folder will open.

4. Within the bin folder, you may double-click the icons for HotFolder.exe or
PortController.exe to open these applications.

Note

You can also create shortcuts on the desktop at this time, if they are not present, using
standard Windows methodology.

Note
For additional information on the Port Controller and Hot Folders, consult the online help.
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Contfiguring clients
for job submission

This chapter contains information on configuring the various clients to submit jobs to FreeFlow
Output Manager.

FreeFlow applications

To configure FreeFlow applications to access FreeFlow Output Manager, use the Printer
Registration application and enter the IP address to the FreeFlow Output server when adding a
printer.

Configuring FreeFlow Web Services to submit jobs to Output
Manager

To configure Printer for submitting jobs from FreeFlow Web Services to FreeFlow Output
Manager:

1. Log On to Web Services as Print Provider.

Go to the Print Settings tab, then go to the Production tab.

Go to Output Devices tab.

Click on the Add button to add a new device.

In the Add Device dialog box, enter the Device Name.

Select Digital for the Device Group.

Select Xerox Output Manager for the Machine Type and click on the OK button.
From the Output Devices on the left side, select the Device created in Step #7.
After selecting the Device, select the Output Channels tab on the right side.
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Note
It is recommended that you select JMF over HTTP.

10. Set the Port to 7781.
11. Select one of the two options based on whether the JDF job type is Intent or Process:
- Select Intent_1.2_General to produce JDF output for Intent JDF jobs.

- Select Proc_DigitalPrinting_1.2_General to produce JDF output for Process JDF jobs.
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Note

If Intent_1.2_General is selected, be aware that unsupported paper sizes (such as
Business Cards) are unsupported and will be rejected by the JMF Service. Use
Proc_DigitalPrinting_1.2_General instead.

12. Set the IP Address to the location of the FreeFlow Output Manager server and click on the
OK button. A confirmation message pop-up to confirm that the changes have been saved.

13. Click on the Device supports multi-queue system link. This shows the list of queues
available in Output Manager. Configure to a queue from the list and save the changes.

Jobs can now be submitted to the Device and the Queue configured above.

Job submission from FreeFlow Web Services is done in two steps:
1. Log In as Print Buyer and Order the job to be submitted to the FreeFlow Output Manager.
2. LogIn as Print Provider and approve the job to be sent to the FreeFlow Output Manager.

See the FreeFlow Web Services documentation for instructions on how to perform these
operations.
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Windows

To configure Windows printer to submit jobs to FreeFlow Output Manager:
1. Tostart,

e Windows Server 2003: Select Start: Settings: Printers and Faxes.

e Windows Server 2008 SP2: Select Start:Printers

e Windows Server 2008 R2: Select Start: Devices And Printers

e Windows Server 2012: Open the Start Menu. Type Control Panel and press Enter.
Select [Hardware, Devices and Printers].

Double-click Add Printer.

Select Next.

Select Local printer attached to this computer and select Next.

Select Create a new port; in the pull-down menu, select Standard TCP/IP Port.
Select Next.

When the Add Standard TCP/IP Printer Port wizard appears, select Next.

Enter the IP address and name for the port, and select Next.

Select Custom for the Device Type.
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0. Select Settings and make the following choices:
a. Under Protocol, select LPR.
b. Enter the name of the FreeFlow Output Manager queue in the Queue Name field.
¢.  Mark the check box for LPR Byte Counting Enabled.
d. When these settings have been made, select [OK]. the Settings dialog closes.
11. Select Next.
12. Select Finish. The Add Standard TCP/IP Printer Port wizard closes.
13. Insert the media that contains your printer driver and select Have Disk....
14. Browse to the appropriate location for your driver, select it, and select OK.
15. Select your printer from the list and click Next.

16. If asked whether to keep an existing driver, which may happen if you are configuring
several similar printers, accept the default and select Next.

17. Enter a printer name in the text field and select whether you wish to use the printer as
default; then select Next.

18. In the Printer Share dialog, enable sharing and enter a share name; then select Next.

19. If desired, enter the location of the printer and a comment in the supplied fields and select
Next.

20. If desired, print a test page; select Next.
21. Select Finish. The printer has been configured.
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Acrobat 9 and X

FreeFlow Output Manager provides support for JMF clients, such as Adobe Acrobat 9 or X to
submit jobs containing job ticket instructions using JDF (Job definition Format).

Note
Acrobat XI does not support JMF submission.

To configure Adobe Acrobat to submit jobs via JMF, perform the following:
1. Perform the following:
— In Adobe Acrobat 9, select Advanced: Print Production: JDF Job Definitions
— InAcrobat X, [View, Tools, Print Production, JDF Job Definitions]
2. Click Submission Manager..., the Add....
At the Submission Settings dialog, enter a name to identify the submission settings.

Under the Submission Options areaq, select Convert to a MIME package and submit to a
JMF device.

— Inthe URL text box, enter http://<IP address of the Output manager server:7781>/
<name of an Output Manager queue>.

Note
Acrobat 9 and X do not support JDF file submission with IPv6 addresses.

5. Click OK twice, then Close.
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Contiguring
Multifunction Device
clients

This chapter contains information on configuring the various Multifunction Device clients that
can submit jobs to Output Manager.

Introduction

To configure a Multifunction Device to access FreeFlow Output Manager, both the
multifunction Device (MFD) and Output Manager must be configured.

The following Multifunction Devices are supported:

e WorkCentre 76xx - full panel color

e  WorkCentre 2xx/56xx

Configuring FreeFlow Output Manager

Once Output Manager has been installed, it can be configured to communicate with various
Multifunction Devices. The configuration process requires two stages. The first stage involves
enabling the feature and adding the specific devices using the System Configuration screen.
The second stage involves configuring a queue to accept jobs from the Multifunction devices.
There is no setup required on the Multifunction device itself.
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Configuring the Output Manager System Configuration to enable
Multifunction Devices

Note

A Multifunction device can be registered with multiple Output Manager servers. However,
each Output Manager server can only register a particular Multifunction device once.

Perform the following to configure Output manager:

1.
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9.

10.
11.

12.

13.

14.
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Double-click the FreeFlow Output Manager shortcut icon on the desktop to open the
application.

Logon as a user who is a member of the Xerox FreeFlow Output Manager System
Administrators group.

Click the System Configuration link at the top of the right of the page.

Select the Multifunction Device Input Client Setup link heading.

Select the Enable radio button option to enable the feature at the Output Manager level.
Select the Apply button to enable the feature

In the Feature Name at Device text box, enter the name that will be displayed at the
service access button at the multifunction device.

Note

The default feature name is “Send to Production.” If you do not enter a custom name for
this feature, that is the text that will appear next to the service access button on all the
devices that communicate with Output Manager.

Select whether to Enable or Disable the Send Confirmation Page to Device option.

— If you enable the confirmation page option, enter the information that will appear in
the header of the confirmation page in the Confirmation Information text box.

Select the Add Device button.

Enter the IP address for the multifunction device in the IP Address text box.

Enter the Administrative Name for the device, and the Device Password into the
appropriate text boxes.

Enter the Multifunction Device Name that you want to appear in the Device Name
column of the Device list on the Multifunction Device Client Input screen.

Enter the Location of the device. This information will appear in the Location column of the
Device list on the Multifunction Device Client Input screen.

Perform one of the following:
— Select OK to add the device and return to the System Configuration screen.

— Select the arrow button to the left of the OK and Add Another heading to add the
device and add another device using this screen. Repeat steps 9-14.
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Setting Up an Output Manager queue to accept jobs from
Multifunction Devices

Once Output Manager has been configured to accept jobs from Multifunction Devices, and
those devices have been identified, queues must be designated to receive those jobs. Each
queue represents a “Job Template” on the Multifunction Device. Multiple queues can be created
and assigned to a single device to give walkup users different submission options. For example,
two different queues could be created for a particular Multifunction Device, each with different
default queue values. Each Multifunction device that is configured using the System
Configuration screen can have multiple queues assigned to it.

If you have not created a specific queue to receive jobs from Multifunction Devices, create that
queue now. For more information on printer and queue setup, see Creating a queue on page 13.
Note

When naming the new queue, ensure that you assign it a name that will identify it as an
Multifunction Device enabled queue. The name you assign does not have to be the name
that will appear on the interface of the Multifunction Device.

Note
If necessary, use the online help for Output Manager to create a queue for this feature.

Setting Default Values for Queues used by Multifunction Devices

The the default values for the following queue attributes should be selected when configuring a
queue to accept jobs from a Multifunction Device. Otherwise, the attribute description will
appear as “Printer Default” on the Multifunction Device, which is not very useful to the walkup
user.

e Color > Print Color As

e  Output Format > Sides Imaged

e  Paper Stock

e  Output Format > Finishing

e Slip Sheets

e Covers

If no queue defaults are selected for the following attributes on the Output Manager

Administrator GUI, the first values on the Multifunction Device drop-down widgets will be
selected:

e Color > Print Color As

e  Output Format > Sides Imaged

e Paper Stock

e Output Format > Finishing

When setting up Paper Stock, defaults should be selected for either the stock name or properties

(holes, weight, color, type, etc..), but not both. If both are selected, the job will be faulted at the
DFE or the Stock Name overrides the properties (the behavior is controller dependent).
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Configuring the Queue

Once a queue has been created, perform the following steps to configure it to receive jobs from
Multifunction Devices:

1.

2.
3.
4

4-4

Select the check box to the left of the queue that you created for Multifunction Devices.
Click the Edit Queue Properties button.
Select the Multifunction Device Setup heading to open that panel.

Next to the Accept Jobs from Multifunction Devices heading, select the Enable radio
button.

In the Queue Name Displayed at Device text box, enter name that will appear on the
Multifunction Device interface. This name will appear in the Job Template list of the
Multifunction Device.

Verify that the items in the Queue Values Displayed at Device list are the items you want
displayed at the Multifunction Device.

Note

Because of the limited amount of space on the Multifunction Device interface, these are
the only attributes that the operator may select to be displayed at the Multifunction
Device.

Note

When values are not specified at the Multifunction Device, the job will inherit the default
value settings of the queue.

— If there are listed items you want to remove, or missing values, select the Edit Values
button. To add a value, place a check mark in the box to the left of the value. To remove
a value, clear the check mark. Click OK.

Next to the Provide Output Controls at Device heading, select the Enable radio button if
you want to enable 2-sided, paper, and output finishing controls at the Multifunction
Device.

In the Present This Queue at list, select the check boxes to the left of the Multifunction
devices that you want to make the queue available. Click the Apply All Settings and Make
Queue Available to Devices button. The queue will appear in the selected devices’ Job
Template list.

Click the OK button at the top right of the Multifunction Device Setup panel.You will be
returned to the Queue Manager screen.
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Multifunction Device configuration

There is no specific configuration steps necessary for the Multifunction device to function.

The following steps cover how to submit a job to the Output Manager server from a
Multifunction device, so that a configuration can be tested.

1. Access the Multifunction device using the username and password specified for the device.
2. Select the [Send to Production] icon on the Multifunction device display.

3. On the Send to Production screen, the Send to Production tab, look for the queue name
that you specified in the Queue Name Displayed at Device text box when you configured
the Output Manager queue. See step 5 in Setting Up an Output Manager queue to accept
jobs from Multifunction Devices on page 3.

Enter the job settings for the job. For example, set the Quantity setting to 25.
Place a document into the Multifunction device scanner and begin scanning.
6. Verify the job was received by the appropriate queue in the Output Manager Job Manager.

Installation and Configuration Guide 4-5



Configuring Multifunction Device clients FreeFlow Output Manager

4-6 Installation and Configuration Guide



Troubleshooting

This chapter contains information on troubleshooting FreeFlow Output Manager installations.
The various problems that you may encounter are divided into the following sections:

e  Permission problems
e Firewall problems
e LPR and IPP problems

e Remote Internet Explorer log in problems

Permission problems

The following is a list of problems and solutions dealing with issues surrounding Output
Manager permissions.

Log In as System Administrator

When installing the FreeFlow Output Manager and creating the new FreeFlow Output Manager
Groups and Users, make sure you are logged in as the PC system administrator.

Users and groups

If the three FreeFlow Output Manager User levels do not work at the lower levels of capability
from any source, make sure you have created all the lower level groups, and have typed them
correctly.

Batch files for Hot Folders and other scripting tasks

If the batch files used for hot folders, etc and scripting tasks work correctly when testing them,
but not when called by FreeFlow Output Manager, the problem is caused by permissions
problems because they were created by the PC Administrator, but are being called by Output
Manager / Hot Folders (owned by FreeFlow Output Manager Administrator).

You must be PC Administrator to make the following changes:

e The PC Administrator User must be in the FreeFlow Output Manager Administrators Group,
and

e The FreeFlow Output Manager Administrator USER must be in the PC Administrator Group.

Installation and Configuration Guide 5-1



Troubleshooting FreeFlow Output Manager

Firewall problems

If any other systems have problems accessing Output Manager using
http://<ip-address>:8080/WebClient/Controller

Then the page may be blocked by the firewall settings or the proxy/router settings. For
Windows Server 2003 or 2008, perform the following to access the Firewall setting dialog:

1. Right-click on the My Network Places desktop icon and select Properties]
2. Right-click on the Local Area Connection icon and select Properties.
3. Click the Advanced tab. Then click the Settings.. button in the Windows Firewall area.

For Windows Server 2012, perform the following steps:
1. Open the Start Menu, type Control Panel, and press Enter.
2. Select [System and Security, Windows Firewall, Turn Windows Firewall on or off]

If the Firewall is set to Off:

e Messages can get through but other systems can not see the FreeFlow Output Manager
server. Check the external proxy settings to determine if there are any gateways impeding
communication.

e If other machines can ping the FreeFlow Output Manager server, check the proxy settings
or the basic network structure and configuration.

If the Firewall is set to On:

e Check if there are any exceptions. If there are exceptions, check what they are. Without
exceptions in the Firewall settings, other systems will not be able to talk to the FreeFlow
Output Manager server. This will block any Internet Explorer access and JMF/LPR/IPP of
input jobs, maybe Hot Folders shared to other users as well as Port Controller input.

e Ensure that the Don't allow exceptions check box is NOT checked.
e Exceptions will be for port numbers and applications such as:
—  Port 515 for LPR
— Port 631 for IPP
— Ports 8080, and 8443 for IE/FreeFlow Output Manager access
—  Ports 9090, and 9443 for IE/FreeFlow Accounting Module access
—  Port 7781 for JMF access

— Port 21 for Send-To-Production/FreeFlow Output Manager access when Send-To-
Production feature is enabled

— Port Controller - Port defined in Port Controller utility

—  Application FreeFlow Output Manager CoreServices, JDF application and JAVA for
applications.
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Changing port assignments

If it is necessary due to a conflict, you can assign alternate ports to Output Manager, the
Accounting Module, or the Send-to-Production feature.

Changing the Output Manager port assignments

If the HTTP and HTTPS ports 8080 and 8443 are unavailable, perform the following to reassign
them:

1. Open the Notepad application.
2. Select File: Open.

3. Navigate to the <FreeFlow Output Manager installation directory>\jakarta-
tomcat\webapps\WEB-INF directory and select the web.xml file. Select Open.

4. Locate the following entry in the file:
<init-param>
<param-name>HttpPort</param-name>
<param-value>8080</param-value>
</init-param>

5. Change the value between the <param-value> and</param-value> tags to an alternate
port assignment for HTTP.

6. Locate the following entry in the file:
<init-param>
<param-name>HttpsPort</param-name>
<param-value>8443</param-value>
</init-param>

7. Change the value between the <param-value> and</param-value> tags to an alternate
port assignment. for HTTPS

8. Save and close the file.

Changing the Accounting Module port assignment

If the HTTP and HTTPS ports 9090 and 9443 are unavailable, perform the following to reassign
them:

1. Open the Notepad application.
2. Select File: Open.

3. Navigate to the <FreeFlow Accounting Module installation directory>\config directory and
select the Tomcat.properties file. Select Open.

4. Locate the following entry in the file:
# HTTP PORT FOR THE SERVER TO START ON
httpport:9090
httpsport:9443

5. Change the values for the httpport and httpsport to the alternate port assignments.
6. Save and close the file.
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Changing the Send-to-Production port assignment

If the ports 21 is unavailable, perform the following to reassign it:
1. Open the Notepad application.
2. Select File: Open.

3. Navigate to the <FreeFlow Output Manager installation directory>\config directory and
select the FtpSpooler.properties file. Select Open.

4. Locate the following entry in the file:

configurableFTPport=21
5. Change the value for configurableFTPport to the alternate port assignment.
6. Save and close the file.

Changing the FreeFlow HotFolder Service port assignment

If the ports 1099 is unavailable, perform the following to reassign it:
1. Open the Notepad application.
2. Select File: Open.

3. Navigate to the <FreeFlow Output Manager installation directory>\config directory and
select the HotFolderService.properties file. Select Open.

Locate the following entry in the file: registryPort=1099
Change the value for registryPort to the alternate port assignment.
6. Save and close the file.
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LPR and IPP input problems

The following is a list of problems and solutions dealing with issues surrounding LPR and IPP
input problems.

Command Line LPR test

Perform the following to test the LPR input using the DOS command prompt from any PC:
1. Enter "LPR -S <OM_ip-address> -P <OM_Queue> <Job URI or Job Path>".
2. Determine whether any of two typical error messages appears:

—  Error 1: “Print server unavailable or specified printer did not exist” appears after the
timeout period.

—  Error 2: “Print server did not accept request - job aborted” appears immediately.

3. Take steps to correct the error:
For Error 1: Check that you have the correct IP-address and you can ping the IP-address.

For Error 2: Check that you have the correct queue name AND check that the queue is
enabled for input.

LPR does not work remotely, but server can LPR itself

An LPR to FreeFlow Output Manager from any network machine fails with the error message
"Print server didn't accept request. Job aborted.” First check that the queues are enabled to
accept jobs.

Try to LPR to FreeFlow Output Manager Queues from the server itself using commands below:
e LPR-S <ipaddress> -P <Queue> <Job>
e LPR-S localhost -P <Queue> <Job>

If both commands work, check the following:
e Check the Firewalls settings for LPR standard port 515 is used.
e Ensure that port 515 is enabled for TCP/IP:

a. Go to the Exceptions tab of the Windows Firewall dialog.
b. Select port 515. Click the Edit... button.
c.  Ensure that the TCP/IP radio button is selected for the port.
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LPR does not work from any machine, including the server itself

In this case, LPR to FreeFlow Output Manager from any network machine does not work, but
also the LPR from the FreeFlow Output Manager server itself does not work. Also, it has been
verified that the queues are enabled to accept jobs. Finally, the Command Line LPR tests
described above do not work.

Perform the following checks:
e Are there other applications on the server, which should not be present. They may be
conflict with the function of FreeFlow Output Manager.
e There may be conflicting Windows Components or Services for Print. Perform the following:
a. Select Start: Settings: Control Panel, then double-click the Add or Remove Programs
icon.
b. Click the Add/Remove Windows Components icon in the left side pane.

c. Look for the heading “Other Network File and Print Services”. If there is a check mark
next to the heading, deselect it. Click the Next button to remove the service.

d. Reboot the server to apply the changes.

LPR input to the server works, but no jobs appear on the FreeFlow Output
Manager queues

Sometimes even with queues enabled, LPR jobs are accepted to the system, but the jobs are
never seen by FreeFlow Output Manager because some third party LPDaemon can accept any
work for any queue name on the system but just sends the data to nowhere.

If something else is receiving the LPR requests and not letting FreeFlow Output Manager see
the input, check if a Windows printer is shared. Also, check what queue names are being used
for this share.

e Determine the following:

e Youcan only have one (1) LP Daemon running on a system. If you have two, they will create
a conflict.

e Ensure you are only running FreeFlow Output Manager on the server and no other FreeFlow
or other products which could cause conflicts. Minor and major conflicts between some
products and Output Manager have been observed.

e Ensure that no LPR/LPD tools are installed on the same system as FreeFlow Output
Manager.
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No Internet Explorer log in for any
remote users

The Console on the server using Internet Explorer (IE) works, but no level of IE access is
available from any other system. Yet, there are no Firewall or Network blocks to
communications. In these cases, other Windows options may be impeding IE requests.

Check that the Internet Information Service (IIS) is inactive in the Windows Components on the
server.

“2027?7” or “---" displayed as the Send-to-
Production icon for a Multifunction
device

A multifunction device that has been previously registered on a FreeFlow Output Manager

has lost its connection to the FreeFlow Output Manager, or it has not been properly deleted
from the FreeFlow Output Manager. If the multifunction device is no longer used or needed, an
administrator should delete the multifunction device via the FreeFlow Output Manager System
Configuration page.

1. Open the FreeFlow Output Manager application and log in as a member of the Xerox
FreeFlow Output Manager System Administrators group.

Select the System Configuration link at the top of the right of the page.

Select the Multifunction Device Input Client Setup link heading.

Select the check box(s) to the left of the multifunction device(s) you wish to delete.
Select the Delete Device button.

o~ whN

Select Yes at the confirmation dialog.

Note

Before moving or changing the IP address of a FreeFlow Output Manager server, always
delete all its associating multifunction devices. In order to remove a multifunction device
that is associated to an obsolete FreeFlow Output Manager, a FreeFlow Output Manager
command can be used. Please refer to FreeFlow Output Manager Command Line Users
Guide, the xomdelreg command.
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HotFolder Service and Client/
Administration GUI

The following errors may occur with HotFolder Service and Client Administration. Refer to Online
Help for more information.

5-8

Error "Cannot connect to Hot Folder Service.”

The HotFolder Administration GUI may display a dialog window to indicate there is a
communication problem between the HotFolder Service and its administration GUI. Refer
to the Online Help topic "Hot Folder tips".

Jobs submitted from Hot Folder has "SYSTEM" as Sender.

The Hot Folder Service is running as the "SYSTEM" default user ID. To change the default
user ID for Hot Folder Service, refer to the Online Help topic "Hot Folder tips".

Remote Hot Folder is not recognized or accessible

The Hot Folder Administration GUI does not recognize a remote hot folder. Refer to the
Online Help topic "Hot Folder tips” to configure a remote hot folder.

Hot Folder processing script fails on remote hot folder

The processing fails on a remote hot folder which may be caused by not having sufficient
access. Choose a different processing program to solve the problem. Refer to the Online
Help topic "Configuring the Default Processing Template”.
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Configuring Options
for JMF Service
Communication

This chapter contains information on configuring the Proxy Server settings for remote file
reference & various signals.

Proxy Server settings

If a proxy server is required to retrieve files using http file reference by the Output Manager, the
settings to the proxy server must be configured.

1.
2.

8.
9.

Access a text editor application on the system (for example, Notepad).

Open the "Jdfjmfgateway.properties” file in the text editor. The file is located in the
C:\Program Files\Xerox\FreeFlow Output Manager\config directory.

Note

For installations on Windows 2008 R2 or 2012, the directory will be C:\Program Files
(x86)\Xerox\FreeFlow Output Manager.

Locate the entry "proxyHost="in the file. Enter the IP Address or server name for the proxy
host following the equals sign.

Locate the entry "proxyPort="in the file. Enter the port number for the proxy host following
the equals sign.

Save and close the file.

Right-Click on the My Computer icon and select Manage to open the Computer
Management applet.

Expand the Services and Applications heading, then select Services.
In the list of services, locate the “FFOM_CoreService” service.
Right-click on the service and select Restart.

10. Locate the “FFOM_JMFService” service in the list, right-click and select Restart.
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SendStatus signal retry/delay settings

If number of retries of delay between retries for the ReturnQueueEntry signal need to be
modified, the following settings are configured.

1. Access a text editor application on the system (for example, Notepad).
2. Open the "Jdfjmfgateway.properties” file in the text editor. The file is located in the
C:\Program Files\Xerox\FreeFlow Output Manager\config directory.
Note

For installations on Windows 2008 R2 or 2012, the directory will be C:\Program Files
(x86)\Xerox\FreeFlow Output Manager.

3. Locate the entry "RQERetries="in the file. Enter a number for the number of retries
following the equals sign.

4. Locate the entry "RQERetryDelay="in the file. Enter a number in seconds for the delay
between each retry following the equals sign.

5. Save and close the file.

6. Right-Click on the My Computer icon and select Manage to open the Computer
Management applet.

7. Expand the Services and Applications heading, then select Services.

8. Inthe list of services, locate the “FFOM_CoreService” service.

9. Right-click on the service and select Restart.

10. Locate the “FFOM_JMFService” service in the list, right-click and select Restart.
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Patch Installation

From time to time it may be necessary to install a software patch to the FreeFlow Output
Manager software. This chapter describes the procedures for installing a patch to FreeFlow
Output Manager.

Installing a patch to FreeFlow Output
Manager on Windows

This section details the software patch installation instructions for the Windows version of the
software.

Installing the FreeFlow Output Manager software patch

In order to install the FreeFlow Output Manager patch, you must be logged in as a user with
Windows Administrator rights.

To install the software patch:
1. Start the FreeFlow Output Manager software patch by double-clicking on the .exe file.

2. Atthe splash screen, select the appropriate language from the pull-down menu and click
OK.

3. At the Xerox FreeFlow Output Manager Introduction screen, click Next.

At the pre-installation summary screen, click Install. The installation of FreeFlow Output
Manager patch begins.

5. After the installation is complete, ensure that the Yes, restart my system radio button is
selected.

6. Click Done. The system reboots.
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